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MIDISCAN Installation

Automatic Install

To start Windows from the C:\> DOS prompt, type:win
Place the MIDISCAN disk into the 3 1/2 drive of your computer.
Choose Run from the Window Program Manager File menu.
Type:[Drive]:SETUP and click the OK button.
MIDISCAN will be installed automatically after you enter your name at the 
install prompt. A directory called C:\MIDISCAN will be created and will act as 
the default directory for your image, .MND and .MID files. See "File 
Management", for information on how to set up unique directories for your 
scores.



Opening MIDISCAN

Find the MIDISCAN icon inside the MIDISCAN group of Windows Program 
Manager. Double-click and youre in there.
During installation, a sample score, Fandango, was loaded into the C:\
MIDISCAN directory along with its associated .TIF, .MND and .MID files. This is
the beginning of Padre Antonio Solers exciting fantasy for solo keyboard 
written in Spain in the mid-1700s. 

To load the sample file, click the Open MNOD icon in the Toolbar. Select 
Fandango.MND. 

To playback Fandango.MID, click the Open Sequencer icon in the Toolbar. 
Press the PLAY button of the sequencer.
When you load MIDISCAN, a new directory, C:\MIDISCAN, is created at the 
top level of your installed disk drive. MIDISCAN will look to this directory first 
when files are opened or saved because this is also MIDISCANs working 
directory. For more information on working directories, see File Management.

Launching MIDISCAN

Launch MIDISCAN by double-clicking its icon in the MIDISCAN group. To 
override the boot screen which appears when MIDISCAN opens, right-click 
anywhere inside the copyright notice. 
The most important thing to learn in MIDISCAN is how to efficiently edit your 
scores after theyre recognized For a quick lesson in MNOD editing, load the 
sample file. Go to the main menu, FILE>Open> and select FANDANGO.
[MND]. Then turn to Editing MNOD.

You may wish to edit the scanned images of your music prior to Recognition. 
For information on viewing and editing your image files in MIDISCAN, go to, 
"Editing Image Files".



Introduction to MIDISCAN    for Windows 

 What youre in for...

MIDISCAN for Windows is the product of over 20 man-years of research 
and development. It was designed as a productivity tool to quickly and 
accurately convert printed sheet music into standard MIDI files. MIDISCAN 
scans and processes printed musical scores and then displays the 
representation on-screen along with the original scanned image for editing 
and cleanup. Converted MIDI files can be played back using a MIDI 
sequencer or displayed and printed. With MIDISCANs internal sequencer you 
can playback, modify and save your converted MIDI files. In addition, you will
be able to reprint a copy of the edited reconstruction, which will likely result 
in a sharper and clearer copy of the original. With third-party sequencing 
software, extra tracks may be added using a MIDI instrument for musical 
input. Using music notation software, converted MIDI files can be imported, 
transposed and printed out in a new key. To operate MIDISCAN, you will need 
a scanning device to image your sheet music, a MIDI sound source, either an 
internal soundcard or an external synthesizer connected by a MIDI interface 
and a printer to create reprinted hard copy of your score. See What youll need...
for system requirements.

MIDISCAN is based on two new, exciting and up to now, unrelated 
technologies: Digital Imaging/OCR (optical character recognition) and MIDI 
(Music Instrument Digital Interface). MIDISCAN uses highly advanced 
decision-making algorithms to classify and reconstruct scanned images of 
printed music into a seamless proprietary digital format that represents the 
original music as standard notation called MNOD. This reconstruction can be 
edited using a mouse and PC keyboard and converted into a standard MIDI 
file.

 Music data is extracted from multiple scans or image-pages during 
recognition. What is output is a seamless interim file or graphic metafile 
called MNOD (Music Notation Object Description). MNOD is MIDISCANs 
reconstruction of the original scanned score. MNOD represents the music 
exactly as it appears on the original printed page and is completely editable 
using notation objects picked from the various MNOD toolboxes with the 
mouse. 

The reconstructed MNOD file may be converted to a standard MIDI file at any
time, although the idea is to first complete whatever cleanup may be 
necessary to correct the MNOD file and then convert it to MIDI. MIDISCANs 
internal sequencer is an excellent tool to use as an aural editor to listen for 
obvious mistakes in the MNOD file.



MIDISCAN recognizes note pitches, note and rest durations, chords, 
accidentals, bar line, ties, clefs, key and time signature. It automatically 
locates staves and systems and corrects skewed images while ignoring non-
note objects such as smudges, titles, guitar tablature, lyrics, fingerings which
do not translate into MIDI. 

MIDISCAN is basically a file convertor: (Bitmap image in; MIDI out.) Although 
it is possible to make unlimited alterations using the MNOD editor, MIDISCAN 
is not intended to function purely as a notation application. 
MIDISCAN will successfully cope with irregular staves per system (See Irregular
Numbers of Staves in Systems.) It can handle scores containing staff lines of 
varying widths, such as piano accompaniments that include reduced solo 
instrument lines. Up to 16 staves per system are supported. MIDISCAN will 
batch-process up to 24 image-pages at one time.
: MIDISCAN is not designed for recognition of manuscript 

(handwritten) scores.



What youll need... 

Certain software and hardware is going to be required to acquire digital 
images of your sheet music as well as to import, modify and print converted 
files. MIDSCAN itself requires only the PC to operate. 

Hardware / Software Required for MIDISCAN
Computer
An IBM AT, PS/2 or compatible (IntelTM 80286, 80386 or 80486). 
Microsoft WindowsTM, version 3.1 or later.
 RAM: 4 megabytes (minimum); 8 megabytes is strongly recommended.
A Windows-compatible video card and mouse.
Nearly all PC computers running Microsoft® Windows 3.1 will be able to use 
MIDISCAN. Apple® MacintoshTM computers are compatible provided they are 
equipped with a PC emulator board or PC emulation software such as 
SoftWindowsTM (Power Macs are recommended when emulating Windows). 
See Macintosh notes. The minimum amount of hard disk space required will 
depend on the number of image-pages scanned. Uncompressed TIFF files 
tend to be rather large; a rule of thumb will be to allocate 1 MB for each 
uncompressed and 100 KB for each compressed bit-page scanned.
Scanning Device
Digital scanners come in a wide variety of shapes, sizes and prices ranging 
from cheap $100 hand-held jobs to $20,000 superhigh resolution drum 
scanners. The results you get out of MIDISCAN are directly related to the 
image quality from your scanner. But as we will see, more is not necessarily 
better.
Most flatbed scanners have an image field of 8.5 in width by 11to14 in 
length. If your scores format is landscape, MIDISCAN will be able to rotate the
image 90o prior to recognition. See To rotate image 90o.... If your music score is 
longer than the scanners imaging field, reposition it or, if necessary, diminish
its size by reducing with a photocopier. 

: Photocopying sheet music prior to recognition may improve 
accuracy by increasing the contrast of faded or yellowed music or by
fattening-up objects in scores with extremely sharp printing, making 
them easier to locate.

Edge-feed scanners are becoming more popular because of their small size. 
They work like old-fashioned washing machines with two counter-rotating 
rollers that grab and feed the paper past the imager. When using edge-feed 



scanners, be sure to preview and crop the image before saving.

If you have a FAX machine with a FAX modem, you will be able to use your 
FAX machine as a scanner. MIDISCAN works quite well at the typical 200 dpi 
FAX resolution (some FAX machines can scan at 300 dpi resolution). Most    
FAX modem software only allow saving images as compressed TIF files. This 
is not a problem. MIDISCAN supports the most commonly used TIFF 
compression schemes, 5 in all, as well as Windows Bitmap (.BMP) and 
Paintbrush (.PCX) image formats.

Hand-scanners will work with MIDISCAN, but they are the least accurate and 
most difficult to use of all scanning devices. If you are going to use a hand-
scanner, scan slowly and evenly in the horizontal direction using a guide or 
tray to minimize twisting. Stitching together of multiple passes to form a 
complete page may or may not succeed, depending on the quality of the 
stitching algorithms in your imaging software. Its probably best to create a 
single image-page for each horizontal pass of the hand-scanner. Distortions 
due to hand movement, low-quality components and less-than-perfect 
stitching algorithms account for most of the problems associated with hand-
scanners. 

In order to simplify the operation of scanners, hardware manufacturers and 
imaging software providers have begun to support a universal scanner driver
standard called TWAIN. TWAIN-compatible applications, including MIDISCAN, 
are now able to access pre-installed driver software and control the scanner.

Sequencing and Notation Software
Once a MIDI file has been created by MIDISCAN, it can be played back with 
MIDISCANs internal MIDI sequencer or it may be imported into a MIDI 
sequencing / notation application for further manipulation. Most musci 
software will allow new MIDI tracks to be recorded over the existing tracks 
(sound-on-sound). Some systems will display, transpose and print MIDI file as
standard notation.

Sequencers are tape recorder analogs that manipulate and playback MIDI 
note streams. New MIDI tracks may be recorded or the entire score may be 
transposed in key. 
Notator/sequencer programs allow users to display, manipulate and print 
music in standard musical notation. They range from expensive desktop 
scoring systems to powerful new sequencers that display and print notation.
MIDISCAN supports all three MIDI file types: 0, 1 and 2. Type 0 MIDI files have
all MIDI channels written to one MIDI track. Type 1 files have one channel 
allocated to one MIDI track. Type 1 files are the most common. Type 2 MIDI 
files have all MIDI tracks written to one MIDI sequence, or song. MIDI files can
even be loaded into MacintoshTM, AtariTM and AmigaTM computers.



Synthesizer
Any synthesizer with a MIDI-IN port can be used as a playback device. To 
support multitrack (Type 1) MIDI files, the synthesizer must have multi-
timbral capability, that is, be able to playback multiple MIDI tracks at once.
Keyboard and modular synthesizers require a MIDI interface device and MIDI 
cables. Consult your synthesizers manual for details.
MPC Soundcards
These synthesizers-on-a-board are installed inside of PCs and do not require 
MIDI interfaces or cables in order to playback MIDI sequences. Special 
software called drivers are usually supplied with the soundcards in order for 
them to operate.



The Language of Music Notation

MIDISCAN was designed to be used by anyone regardless of musical training.
However, some knowledge of the basics of music notation will be helpful 
when using it. The following are descriptions of the most common elements 
and objects you will encounter while working with MIDISCAN. These do not 
appear in alphabetical order, but in top-down order starting from the 
document level and going to the object level:

Score Types
A score is the finished musical piece as it appears printed on paper; ready to
be played. If it is a hand-written document, it is called a manuscript.
Part scores are printed in sets for each individual instrument. Players read 
from their own unique set of pages. For example, a duet for guitar and flute 
would be printed in two separate sets: one for the flute player and one for 
the guitar. Staves of part scores flow like a book where each staff line 
appends to the one above it. 
A unique type of part score is that printed for a solo instrument and its 
accompaniment, where the solo staff line is printed with narrow staff lines 
and with smaller fonts. For the purpose of processing this type of score in 
MIDISCAN, it should be considered as ensemble and not a part score. 
Ensemble scores have multiple staff lines connected by a vertical bar or 
brace (usually along the left-hand edge of the music). When joined in this 
way, each staff line represents a different part or instrument played in 
ensemble. Ensemble scores may have 2 or 20 parts joined together in a 
single a 
system all sounding simultaneously. Unlike part scores, each staff lines does 
not necessarily append one to the one above it.
Piano music, where two staff lines (left-hand and right-hand) are joined into 
one system, is regarded as ensemble. MIDISCAN assigns the left and the 
right-hand staves to separate MIDI tracks.
Scores with an irregular number of staves per system appear mostly in 
popular song books. Here, the accompaniment (usually piano) has an 
introduction of several measures (2 staves per system) followed by the 
addition of a voice line (3 staves per system). See Irregular Numbers of 
Staves in Systems for additional information.
Miniature scores and some hymnals are printed in unusually small font sizes. 
These sorts of scores will process best when enlarged by a good-quality copy
machine and then rescanned. When copying, be sure to avoid skewing.
Some scores are wider than they are high. Theses landscape layouts ought 
to be rotated prior to processing. See To rotate image 90o... for information 



on rotating a scanned image.
Folio-sized and conductor scores may need to be reduced on a copy machine
before scanning. If the score must be reduced more than 50% in order to fit 
the imaging area of your scanner, you may consider scanning each full-sized 
page twice and treat each scan as one image-page.



Notation Objects
System
A grouping of multiple staff lines linked together by a solid line or bracket 
along the left margin is called a system. All staves belonging to a system are 
played simultaneously. In ensemble scores, each system appends to the one 
before it. A single page of a symphony conductor's score, containing 10 or 20
staff lines per system, may represent only a few seconds of music!

 Staff Line (Staves)
The field on which notes are represented is called a staff or stave. At the core
of every stave are five horizontal staff lines. Each successive line and space 
are equivalent to a full step in note pitch. The higher the note appears on the
stave, the higher its pitch. Every stave is associated with a particular clef 
sign which determines its relative position within the full pitch spectrum.
 Clef Sign
The clef sign at the beginning of each stave identifies which pitch class that 
stave belongs to. The lowest instruments are written in the bass clef, 
intermediate instruments and voices often use one of three C clef classes 
while higher-pitched instruments, in addition to the right-hand part of a piano
score, are scored in the treble clef. The clef sign always appears at the 
beginning of every staff line and in the first measure where a change of clef 
sign occurs.
 Key Signature
The key signature, along with the clef sign, appears at the beginning of every
line; it is also found in the measure where a change of key occurs. The key 
signature defines the tonal center of the piece. By counting the number of 
sharps or flats in the key signature, the key signature can be determined. 
 Time Signature
Time signatures usually appear only once: at the beginning of the stave in 
the first measure of the piece. They will also appear when a change of time 
signature occurs. Time signatures indicate both the number of beats per 
measure (numerator) as well as which note value is given the fundamental 
beat (denominator). The sum of note duration values in a given measure 
must equal the value of the current time signature.
Measure
Staff lines are segmented into equal time divisions called measures. 
Measures are the building blocks that provide structure for music. The sum of
note and rest durations within each measure must equal the value of the 
current time signature. 



 Bar Line
Bar lines are the vertical lines which define the beginning and ending of 
measures.
 Note/Rest
A note is the fundamental unit of tone. The duration of a note is determined 
by a) its note value and b) the tempo at the moment it is sounded. The notes
vertical position on a particular staff line determines its pitch. 
Rests are equivalent to note durations but instead, they represent silence. 
They are like place-holders used to keep the rhythmic structure of the 
measure intact. 
Accidental
Note pitches often range outside of the tonal center defined by the key 
signature. An accidental shifts its associated note up (sharp) or down (flat) 
by 1/2 step. Accidentals may also be doubled. An accidental remains 
effective only for the remainder of the measure in which it appears. A natural
cancels a notes current accidental.
 Dot of Prolongation
Notes and rests that are dotted have the value of their duration lengthened 
by 1/2. For example, a dotted quarter note is equal in duration to three 
eighth notes. Double-dotted notes increase the notes duration by 3/4 of the 
original.
Tuplet
Some notes belong to a special rhytmic class called tuplets. These include 
triplets, quintuplets and sextuplets. A tuplet is a group of notes, usually 
marked with a bracket, that are subdivided within a single beat, equal in 
duration to the notes next higher value. For example, a triplet of three eighth
notes is equal in total duration to one quarter note.
TupletTuplet
A tie links two pairs of notes of the same pitch whose durations are 
combined so that both notes are played as if one note. Ties are often used to
sustain the sound of a note across more than one measure.



Imaging for Music Recognition

In order for MIDISCAN to process music notation, the sheet music must first 
be acquired and transformed into a digital image that a computer 
understands. The following are terms and definitions most commonly used in
imaging. It is not necessary to know a lot about digital imaging to use 
MIDISCAN, but you might find the information helpful.
Bitmap
 A bitmap is a digital or rasterized image. A bitmap is similar to a photograph
in a newspaper where the image is simply an array of tiny dots. A computer 
stores the bitmap in memory as an array of numerical bits that are located 
by coordinates. Displayed on a computer screen, a bitmap is a 2-dimensional
array of many tiny dots, or pixels. Each pixel is digitally stored as one bit of 
information: on=0 or off=1. Its a map made up of bits of data.
: If you are using MacintoshTM for scanning, you will have to convert 

your Mac TIFF files to PC TIFF files using a graphics program or utility
capable of transforming image files from Mac to PC formats.

Scanner
A scanner is like a copy machine for computers. It optically senses and 
transmits an image of greater or lesser fineness or resolution. A scanner can 
be hand-held, edge-fed or full-page. Scanners usually come with software 
that convert acquired images into standard graphic formats so images can 
be read by many different programs. Most scanners include a controller card 
that is installed into the PC to drive the scanner. 
CCDs
Scanners have many tiny sensors called charged-coupled devices (CCDs) 
packed in an array. Generally speaking, the more CCDs in the array, the 
highter the resolution of the scanner. 
Resolution
The resolution of a scanner is measured in dots-per-inch (dpi). Many 
scanner/imaging products use algorithms that increase the resolution beyond
the physical number of CCDs in the scanner. For example some scanners 
with 300 CCDs per inch can output TIFF images at 1200 dpi or more. This is 
referred to selectable resolution. 
Optimum image quality of a scanner is its true (optical) resolution where 
output is no more than the actual number of CCDs per inch on the optical 
array. The recommended resolution for MIDISCAN is 300 dpi although it will 
handle resolutions as high as 400 dpi and more. 
: Higher resolutions DO NOT NECESSARILY equate to higher accuracy. 



There is a point of diminishing returns when the optimum resolution 
is exceed. At 350-400 dpi, recognition accuracy of scores with very 
small fonts may be improved but scores with normal font sizes may 
actually suffer decreased accuracy. One solution to processing 
scores with smaller fonts is to photocopy and enlarged them first.

As a rule, hand scanners have fewer CCDs per inch than flatbed or fullpage 
scanners which are more expensive. This one reason why hand scanner 
output is less desirable than full-page.It is best if your scanner output has 
true 300 dpi.
Skew
Skew is the angle or amount a documents image is rotated from its normal 
orientation.



Music Recognition

Scanning sheet music transforms it into a digital image. This image can then 
be processed by a music-reading program. 
What is produced after recogntion is a representation or reconstruction of the
original music. The difference is that the reconstruction becomes encoded 
with data about each music element, allowing for manipulation of 
individualobjects, global transformations such as key and time changes and 
for conversion into other data formats, such as MIDI.



MIDI (A Little History)

In the early 1980s, manufacturing of digitally-based musical instruments 
began to explode. One big problem was that these devices could not be 
synchronized with each other. Networking them could provide musicians with
undreamt-of possibilities. The first MIDI device ever sold was a box that 
slaved a drum machine to a synthesizer... thus, MIDI (Musical Instrument 
Digital Interface) was born.
The next step was to standardize the form in which note information was 
being sent through these MIDI devices. Manufacturers of digital instruments 
soon agreed to support a digital file format where a single keyboard or even 
a computer (!) could drive multiple synthesizers. The International MIDI 
Association published the Standard MIDI Files specification in 1982.
MIDI files are efficient and elegantly constructed. Notwithstanding its 
detractors, MIDI has become the de facto international standard for digital 
description of music.
Standard MIDI files are transportable across platforms much as ASCII text 
files are. If transporting the MIDI file from a PC to another platform, some 
utility will be required to allow the resident disk drive to read the DOS-
formatted floppy disk. The Macintosh Apple File Exchange utility allows a 
Macs disk drive read and write DOS-formatted disks. Ataris TOS system 
software can read DOS-formatted disks directly.
MIDI files created on a PC will have a Macintosh filetype called MDOS. Using 
Resedit or some other file utility, change the filetype to midi. No creator is 
necessary.



Scanning Sheet Music

To begin scanning, prepare your music and scanner. Push the Scan icon in 
the Toolbar.    Your first choice will be to SELECT a scanner whose TWAIN 
driver has already been installed into Windows. If no scanner device is 
appears, check that your scanner is TWAIN-compliant and that you have 
loaded its driver. If you are not using a TWAIN-compatible scanner, turn to 
Using non-TWAIN compliant scanners.
After selecting your TWAIN scanner, push the Scan icon again. Your scanners
imaging software will now open up and your scanner should make a quick 
pass, displaying a low-resolution image of your music in a preview screen.
Prior to final scan, you will need to make a couple of settings. If possible, 
save the presets for future music scanning sessions:
Set image type to Black-and-White (or line art, drawing, binary or 1 bit-
plane). Do not select Grey Scale or Color image type.
Set your scanners resolution to between 300 and 400 dpi. This is the 
optimum range for MIDISCAN. 1500 Do not exceed an image-page file size of
KB (around 400 dpi). Pages with resolutions higher than 400 dpi may contain 
more data than MIDSCAN or your RAM can allocate memory for. Remember, 
a 600 dpi image is 4 times the size of one scanned at 300 dpi!
: Higher resolutions do not necessarily equate to higher accuracy. 

There is a point of diminishing returns when the optimum resolution 
is exceed. At 375-400 dpi, recognition accuracy of scores with very 
small fonts may be improved but scores with normal font sizes may 
suffer decreased accuracy. The best solution to processing scores 
with smaller fonts is to enlarge them before scanning, either with a 
photocopier or using by using the scaling option offered with some 
scanners.

: Keep horizontal staff lines flat. Avoid skewing image.
With your mouse, crop-in the area of containing the music inside the preview
screen. Leave at least a 1/4 margin of white space around the top, sides and 
bottom of the music.
Press the Final or Final Scan button. Give the page you are scanning a name 
and select TIFF Uncompressed as the output image type. Press OK. The final 
high-resolution scan of your music will begin.
When the scan is finished, you will be given a choice to continue scanning 
new pages, save page and begin recognition or open the scanned image in 
MIDISCANs Image Editor. 
Select Save as... and Begin Recognition.



Turn to "Music Recognition".



Using non-TWAIN compliant scanners
If your scanner is not TWAIN-compatible, you should open its imaging 
software, refer to Section 4.2.c. and adjust image settings.
Launch the imaging software that came with your scanner. 
: You will be creating one image file for every page of music scanned. 

If using a hand-scanner, single passes of the scanner ought to be 
saved as individual image-pages.

Place the first page of your score face-down on the glass of the scanner. If 
the imaging software youre using has a Preview feature, preview the image 
first. Look at the preview to see if you are capturing the full image of the 
music with minimal amount of skew. 
After scanning the first page, name the page and save it to the C:\MIDISCAN 
directory. It is recommended that multiple-page scores are saved in a easily 
understood numbering system, i.e. Page1.TIF, Page2.TIF, etc. MIDISCAN will 
process multiple image-pages based on the list of file names you select.
Scan the remaining pages of your score, if any. 
Save the remaining image-pages to C:\MIDISCAN.



Music Recognition 

Push the Recognition icon in the Toolbar. 
Recognition Setup
In the Recognition Setup dialog box, you will be asked to select the score 
type and the relative size of the region surrounding the staves of your score.

Score Processing
Fully Automatic Score Processing
MIDISCAN automatically processes multiple-page scores in an 
eyes-off/hands-off mode. It also will automatically cope with scores 
containing irregular numbers of staves in systems, provided the irregularity 
occurs on the first page. This is the default setting.
User Confirm
If your score contains multiple collapsing and expanding staves beyond the 
first page or if you Cancelled out of Staves Localization because locator tabs
were being misplaced, select User Confirm. In this mode, staves localization 
can be corrected by you. When User Confirm is selected, each page is 
localized in the User Correction Mode. For information, turn to "User Correction 
Mode". For information on dealing with scores containing collapsing and 
expanding systems, see Irregular Numbers of Staves in Systems. 

Score Structure
 In Recognition Setup dialog box, you may choose the proper score structure 
for your music: Ensemble or Part.
Ensemble scores have two or more staves per system. For the purposes of 
MIDISCAN, piano music, piano/vocal accompaniments and orchestral 
/conductor scores are to be regarded as ensemble scores.
: MIDISCAN will handle up to 16 staves per system.
Part scores have a single, contiguous staff line, equivalent to the flow of text
in a book. Each score part represents an individual instrument of a group 
such as a quartet, trio or orchestra. 
: Scores written for single instruments, such as solo guitar or violin 

may be processed as either ensemble or part scores (1 stave per 
system). See Paragraph 2.6,The Language of Music Notation for more 
details on score types.

Select Ensemble Score Selection. If you are scanning apart score, then turn 
to Part Score Selection.



Recognition Region
MIDISCAN searches a fixed area around each stave for notation objects. This 
is called the recognition region. Selecting the correct size for the recognition 
region is a function of how far outside the staff lines objects appear and how 
much white space there is between each stave.
: For most music, Normal Region setting works best.
Choose the size of the region you want MIDISCAN to search for notes. The 
options, Normal, Wide and Narrow, refer to the vertical height of the 
recognition region. Part scores and music with very little space between staff 
lines should probably be processed with Narrow region selected. The Wide 
setting works best with scores containing extreme ledger lines.
Press OK to accept Recognition Setup selections. 
: If you are running Norton Desktop for WindowsTM you will need to 

disable File Assistant. It is not compatible with MIDISCAN's Windows 
filename convention.

The Files Selection dialog box will now open.
Click on a directorys folder to list all previously scanned files (image-pages).
In the File Name window, click on the filenames you want processed in the 
order you want them processed. (SHIFT+ Click for multiple names.) When 
Select button is pushed, the names are copied over to the Selected Files list.
: Image-pages are processed in the order they appear in the Selected 

Files list, from top on down. You many want to reorder your 
filenames in the Files Selection Dialog box since Windows orders 
filenames alphanumerically.

To remove a selected image-page from the Files Selection list...
Use the Unselect button and click on the files name.
To reorder selected image-pages in the Files Selection list...
Use the Reorder button, click on the selected files name and click anywhere
in the selected file list to replace it.
To Start Recognition of Selected Files...
Click OK. 
: Press Cancel in the floating dialog box to cancel processing any time

during recognition.
During automatic recognition, all selected image-pages are batch -
processed. Recognition will take from 1 to 5 minutes per page depending on 
processor speed and density of your notation. A 10-page score will take from 
10 to 45 minutes to process, enough time for a short workout or jog around 



the block. 
Staves Localization
The first analysis MIDISCAN makes of your score is to determine its structure 
(staves per system). Then it localizes or locates the position of each 
horizontal staff line. Black locator tabs are dropped where MIDISCAN expects 
the beginning and end of each staff line ought to be found. Every page 
undergoes localization first.
If all goes well during recognition, MIDISCAN will chirp and return to the first 
page of the score. The Save As... window will appear with an .MND file 
extension selected.
To accept the default .MND filename, select OK. Otherwise, change the name
of your MNOD file to whatever name you wish. Do not change the .MND 
extension.
: Do not use File>Save As... for the purpose of changing extensions in 

MIDISCAN. Files must be converted and reassigned proper 
extensions by MIDISCAN first.

To begin editing, turn to Editing MNOD Files.

User Correction Mode
If during staves localization, an inconsistency in the expected staves per 
system structure is detected, recognition will be suspended on the page the 
inconsistency is found. Remember that the purpose of MIDISCAN is to 
logically string together segmented staff lines into seamless MIDI tracks. 
A box will pop up notifying you of the situation and will ask if you want to 
Correct or Cancel localization. Choosing Correct will restart staves 
localization in User Correction Mode beginning on that page. Cancel will 
terminate Recognition. Each staff line will be re-localized on the page where 
the inconsistency was found. You will be given the chance to accept or 
reposition each locator tab after it is dropped.
Check the position of the locator tab as it drops at the beginning of the first 
staff. The tab should outline the top and bottom staff line while touching the 
margin with its edge. Relocate the tab if necessary by positioning the cursor 
over the tab and dragging to its proper location. Resize by pulling on any of 
its edges.
Push Accept when tab is properly positioned. Repeat procedure with tab at 
end of the line. Continue pushing Accept until all tabs are properly 
positioned on the page.
: Pushing Correction at any time will restart localization



If a staff line was skipped during localization...
Accept the position of all locator tabs until you reach the end of the staff line 
just above the one that was skipped.
Push New Stave. Two new tabs will drop just below the current line. Drag 
the left tab to the beginning of the skipped stave. Reposition the right tab to 
the end of the skipped line.
 When all tabs on the entire page have been properly localized and accepted,
push Done. The Ensemble Score Description Dialog box will open. This box 
reports the number of staves and systems found on each page and how 
many were regular and how many irregular. 
If the page being corrected is Page 1, you will be able to manipulate the 
number of staves found in both regular and irregular systems. Remember 
that the total number of staves must equal the number of staves actually 
localized. If they do not, then a staff line was probably skipped and 
Correction will have to be selected to re-localize staves. 
The Rule of Regularity is this: A Regular System will contain the exact 
number of staves found in the last system of the 1st page.

Irregular Numbers of Staves in Systems
MIDISCAN automatically copes with scores containing irregular numbers of 
staves in systems, such as vocal/piano accompaniments that go from 2 to 3 
staves per system. MIDISCAN assumes that such inconsistencies in the 
staves-per-system structure occur only on the first page of the score and 
after that, the number of staves in each system ought to remain consistent. 
As we will see, some scores are not so perfectly-behaved.
To cope with collapsing and expanding systems in order to maintain 
consistency of staves per system...
Examine the score and decide how many staves per system will determine a 
regular system. Do this by selecting the most common number of staves per 
system. e.g., for a score having mostly 3 staves per system with an 
occasional 4-stave system, 3 staves per system will be considered regular. 
Then identify those parts that will either be skipped or added (as empty 
staves) in order to maintain consistency. For example, in the middle of a 
cantata, a soprano part might split between soprano 1 and soprano 2 for one
or two lines. Soprano 2 will have to be sacrificed by telling MIDISCAN not to 
recognize it after it is localized.
: Remember the rule that the number of staves found in the last 

system of Page 1 is considered regular by default.
To ignore a specific staff line within every system of every page... 
Select User Confirm mode prior to beginning Recognition. After staves are 



located, press Done. The Ensemble Score Description dialog box will inform 
you of the staves per system structure as seen by MIDISCAN. In the 
Selected Staves column, click on the stave number to be ignored for the 
page just localized. Here, the first stave of each system was selected to be 
ignored during recognition.

It is assumed that the number of staves per system will be equal on that 
page. If not, you will need to tell the program to ignore a particular staff on a 
line-by-line basis.
To ignore one particular staff line during Automatic Staves 
Localization... 
Press Skip Stave in the flying dialog box after that particular staff line is 
localized in User Confirm mode. It will be skipped during recognition.
: A quick-and-dirty method of coping with expanding staff lines is to 

simply delete them in the Image Editor prior to Recognition. See 
"Editing Image Files".

To add an extra (or empty) staff line...
Accept the position of all locator tabs until you reach the end of the line 
above where the empty stave should be. Press New Stave in the floating 
dialog box. Two locator tabs will drop in the empty space just below the last 
staff line located. Move the tabs to where the phantom staff line ought to be.
At the end of the page, press Done. Recognition will either ignore the 
skipped stave or read the new stave and insert empty measures.

Part Score Selection
For ensemble score processing, turn to Score Structure.
Use the numerical scroller in the upper left-hand corner to enter the number 
of total parts of your score. Choose between 1 and 16 parts. A flute and 
guitar duet, for example, will have 2 parts, a trio 3, etc. 
In the Pages in Part column, select the number of pages scanned for each 
part.
Click OK.
The Files Selection dialog box will now open.
Find the working directory where youve stored your previously scanned files 



(image-pages) in the left-hand window. To view its contents, click on the 
directorys name.
All .TIF files residing in a selected directory will be displayed in the middle 
window.
In the File Name window, click (or click+SHIFT for multiple names) the image
filenames you want processed. 
Use the Select button to move each image-page over to the Selected Files 
list. Select them in the same order you indicated in the Parts Description 
dialog box. i.e., select all the pages of Part1 in order first, then all of those 
belonging to Part2 next, etc.
Click OK. Recognition begins.
For more information see staves localization .
Recognized music data is extracted from multiple image-pages and compiled
into one seamless file format called MNOD (Music Notation Object 
Description).



Editing MNOD Files

Following recognition, MIDISCAN will automatically open to display the image
window in the upper half of the screen along with its associated MNOD 
reconstruction in the lower half of the screen. It is in this environment, the 
MNOD Editor, where you will correct mistakes made either in recognition or 
in the score itself. 
Whenever the terms click and select are used, it will mean to click the left 
mouse button on an object or choice. When clicking of the right button is 
required, the term right-click will be used. Double-click will mean to click the 
left button twice, quickly.
Notice that the MNOD window displays music notation objects in the same 
position as they appear in the original image. Graphical attributes are 
captured along with the musical data of the original. This will help you to 
correct misrecognized objects by allowing you to compare them directly with 
their corresponding images in the image window. 
During editing, you will be able to access any MNOD page by selecting Go To
Page from the Edit MNOD Main Menu item. Using the scroller, select the 
page to jump to and press OK. This is a particularly valuable feature when 
you are using the MIDI playback sequencer to aurally edit your score. Jot 
down the measure numbers where an obvious problems occur, Exit the 
sequencer and simply Go To the pages required.
You may also choose to print out the MNOD file anytime as an alternative 
method of comparing to the original score. Go to File>Print in the Main Menu.
: Understand that in MNOD, note attributes such as stem direction and

beam grouping will not affect MIDI translation. These attributes are 
helpful as visual aids when comparing objects in the MNOD and 
image windows. Occasionally, eighth or sixteenth notes appear with 
an unattached beam segment. Beamed and flagged notes of the 
same duration will have the same MIDI duration. 

Toolbar
Use the Toolbar on top of the screen to quickly access edit functions.

Viewing the MNOD File

Push either the Zoom-In or Zoom-Out icons in the Toolbar to change the 



scale of your view. To check the scale, look inside the View menu selection. 
To maximize the MIDISCAN window, click on the up arrow in the far upper 
right-hand corner of the window display.
Use the scroll bar on the right-hand side of the window to navigate up and 
down a page.
To scroll to the next image-page, click the arrow in the lower right of the 
window when reaching the end of a page.
To quickly flip through Image/MNOD-pages, use the Next-page and Back-
page icons in the lower right corner. You may also use the Page-Up and Page-
Down keys on your keyboard to page forward or backwards.
Active Staff Line

Only one staff line in the MNOD display will highlight black at a time. This is 
the active staff line for editing. All other staves will show up as grey and will 
not be editable. 
Scroll up or down the page using the scroll arrows or slider to move the 
active staff line between staves. 
Edit Toolbox

The Edit Toolbox appears along the left-hand side of the screen. This Toolbox 
contains every object you will need for editing MNOD files. Icons in the upper
Main display represent object groups, each group contains a subset of 
notation objects. To open an object group, click on its icon. The objects 
subset will appear in the lower Display toolbox. Clicking any object makes it 
active. The last object selected in any given object group will display as the 
representative group icon until a new object is selected.

MIDISCANs most important edit functions are ergonomically mapped to the 
lower left-hand section of the PC keyboard. To begin, place your left index 
finger on the C key of the keyboard. This is the hand position for editing. This
arrangement will allow for efficient left-hand / right-hand coordination and 
will greatly enhance editing of your MNOD files. You will soon find editing fast
& easy.

Insert/Change Modes
With your left index finger, press the C key several times. Notice how this 
toggles between the Insert and Change icons in the Toolbar. In Insert mode,
the cursor becomes the selected object. In Change mode, the cursor 



becomes an arrow with the selected object next to it. 

Insert mode allows you to insert objects while clicking anywhere in the 
active staff line. This is the Toolbox icon.

 Change mode allows you to change existing objects to the selected 
notation object.
Delete / Delete Any Modes
With your left middle finger, toggle the X key. Delete removes any object 
that is selected in the toolbox group. It also will remove an entire chord 
cluster when clicked.
 Delete Any will remove any object that is clicked with the mouse. Use it to 
remove a single note from a chord cluster.
Single-note / Cluster-note Modes
With your ring finger, hit the Z key to toggle between Single and Cluster 
modes. These are the main modes used to Insert and Change notes. 
Single-note mode will drop a note object anywhere in the MNOD window. 
Cluster-note mode is used for chord-building. With Insert active, a new note
will attach to an existing note stem and inherit the same duration of the 
original note. 



Inserting Notes and Building Chords
To Insert a single note...

Toggle the C for Insert mode or click on the note icon.
CNTRL+click on a selected note in the active staff line. The cursor will 
become that note. You may also select a note from the Note object group. 
Wherever you click in the active staff line, the selected note will drop to the 
closest line or space. For closer views, push the Zoom-In icon.
: Stem direction of an inserted note is determined by its vertical 

position on the staff. Stem direction of inserted notes automatically 
changes when the cursor crosses the middle staff line. Toggle the S 
key to change default.

Click on or above the middle staff line (B in the treble clef) to drop a note 
with a downward pointing stem. Click below the middle line to insert a note 
with the stem directed upwards.
By inserting notes with a right click, the above rule will be reversed: Stem up
above the middle line, stem down on or below the middle line. Think left-click
to insert notes with standard stem direction and think right-click to insert 
notes having non-standard stem direction.
To Insert a note to an existing chord cluster (chord builder)...
In Cluster-note mode, an inserted note will assume the duration value of the 
note(s) to which it attaches. 

Cluster Press the Z key to select the -note or press the chord icon in the 
main Toolbox display. 
In the active staff line, click in the appropriate space or line near an existing 
note. The note being inserted will attach itself to the existing notes stem. If 
an inserted note joins one that is already dotted, the inserted note will also 
become dotted.
: All notes of a single cluster belong to one vertical event. For the 

purpose of MIDI conversion, all notes and rests falling on the same 
beat must be vertically aligned regardless of their horizontal position
in the original score.

: Inserting a note with a right click reverses the direction of the note 
head in Cluster-note mode from standard direction relative to its stem to 
non-standard. 
Changing Note Pitches
Hold the SHIFT key down and drag any note or rest object with the left 
mouse button depressed. You will be able to change note pitches this way.





Editing Shortcuts (Quick-Keys)

Quick-Select of MNOD Objects for Editing
To quickly select any object for Inserting or Changing...
Hold the CNTL key down with your small finger and in the MNOD window 
click on an object that you want to select. The cursor will become that object.
Any notation object in the active staff line selected with CNTL+click will 
cause the cursor to inherit the objects attributes.
Dot, Tie and Beam Toggles
Hit the D key. This toggles you between Insert a dot and Delete a dot modes.
Notice how the cursor alternates between a solid Insert dot and greyed-out 
Delete dot.
Hit the V key. This toggles you between the solid Insert tie and greyed-out 
Delete tie modes.
With the single note group in the toolbox open, hit the A key. This toggles 
you between Right beamed, Inside beamed and Left beamed note 
configurations.
Change Stem Directions When Inserting Notes
In Insert mode, the S key toggles default note stem direction. Right-clicking 
when Inserting a note reverses the selected stem direction. 
Delete Multiple Ties in a Selected Region
To delete all ties in a selected region, hit the G key. Drag the mouse to define
a box inside the active staff line that contains unwanted ties. Right click 
inside the box to delete all ties inside the defined region. 
Use Number Keys to Select Note Values
To quickly select note values, hit the appropriate keyboard number: 1 = 
whole note, 2 = 1/2 note, 3 = 1/4 note, etc.

Select Tuplets Key
The T key activates.Tuplets group. 
Select the required Tuplet from the Display Toolbox. Triplets are selected as 
the default. 
Drag the mouse to box around desired notes to select as a Tuplet. Right-click 
inside the box.
To delete a Tuplet, toggle the X key and click on a note of the tuplet.



Quick-group Icon

Pushing this icon gives you a selection of three Quick-Group features. Select 
one of three special icons to its left:

To quickly group notes into a single Vertical Event...
Sometimes in music notation, simultaneous-sounding notes and rests that 
belong to different voice lines actually appear horizontally offset from each 
other on paper, usually because of a lack of room. Use this function to ensure
Inserted notes and rests will have identical Note-on MIDI times. 

Select this icon and drag a box around inserted notes or rests that you want 
to occur simultaneously in MIDI.
Right click inside the box. If you hear no beep, the grouping was successful. 
Notice that the objects do not physically move.
To quickly group flagged notes into a beamed sequence...
Flagged notes can be transformed into a beamed sequence. Flagged notes 
do not have to be of the same value to group into a beam.

Select this icon (or push the B key) and drag a box around a group of flagged
notes. Then right-click inside the box. 
To quickly group ties to delete...
Sometimes MIDISCAN misinterprets a mass of dots or slurs as ties. This 
feature allows you to easily remove ties from a selected region.

Select this icon (or push the G key) and drag a box around a region in the 
active staff line that contains unnecessary ties. A right-click inside the box 
will delete all ties within the region.
Flag / Beam Toggle Key
With Insert active, the F key toggles between flag and three beam attributes
for any selected note. 



General Editing Features

To Unify Time and Key Signatures...

This feature unifies time and key signatures throughout the score based on 
the time and key signatures found in the topmost staff line of each system. 
This applies to change-of-key and change-of- time signatures as well as to 
the initial signatures found in the first measure.
If necessary, change the time and key signatures in the first measure of top 
staff line on page one. 
Go to Edit MNOD in the Main Menu and select Unify Key and Time 
Signatures.
To Insert or Change a clef sign or change-of-clef sign...

Select the Clef icon from the Main Toolbox.

Select a treble, bass, soprano, alto or tenor clef from the clef object group.
Toggle the C key until Insert is active, click inside the measure where it 
belongs. 
To change an existing clef sign, toggle the C key until Change mode is active 
and click on the existing clef.
To Insert, increase or diminish a key signature...

If the key signature is missing or incorrect in the first measure of the score, 
select the accidental icon from the Main Toolbox.

Select the appropriate sign from the Accidental group.
In the active 
staff line, click on the clef with Insert active until the correct number of key 
signs is correct.
To reduce the number of signs in the key signature, click on the clef sign with
Delete active. The signature will diminish by one with each click.
NOTE: If there are no change-of-key signatures in the body of the score you 

are processing, you may unify all key signatures in your score by 



selecting Edit_MNOD>Unify Key Signatures.
To Insert, increase or diminish a change-of-key signature...
Select a key symbol from the key signature object group. Click anywhere in a
measure while Insert is active.
Additional clicks add extra symbols to the key change.
The number of symbols in the change-of-key sign can be diminished by 
clicking on the sign while Delete is active.
To Insert a time signature or change-of-time signature...

Push the  time signature icon in the Main Toolbox.

Select one of the preset time signatures from the display.
To build a custom time signature, push the N icon (numerator or upper 
number of the signature) from the display. Click the selector arrows to the 
required number.
Click on the D icon (denominator or lower number of the time signature). 
To insert, click anywhere in the active staff line. 
To Change a time signature...
Select a preset time signature or a custom time denominator.
Click on an existing time signature with Change active.
 Click on the signature with Delete active to eliminate it.
To Insert or Change an accidental...
Click on the key sign object group with INSERT active.
Select the required accidental from the Display Toolbox .
Touch the head of the note with a click of the mouse. The 
accidentalassociated with the note will be inserted. With Delete active, the 
accidental will be eliminated.
Inserting a key sign while touching a bar line inserts a change-of-key 
signature.

 To Insert a dot of prolongation...



Select the dot of prolongation from the Main Toolbox.
Click on the head of any note. Click again for a double dot.
Pushing the dot icon again enters the delete dot mode.
With Delete active (toggle the X key), clicking on the note head will remove 
dots from a note or rest one at a time.
To Insert or Change a tie...

Select the Tie object group. 

Click on the first notehead of a tied pair. Insert will tie the note to its mate. 
To tie chords together, select the group tie icon. Click any notehead of the 
1st group.
With Delete, any tie will be removed from a tied pair.
To place a half-tie at the end of a staff line, click on the last note of the staff. 
To complete the tie, another half-tie will have to be created at the beginning 
of the next line.
To create a half-tie on the new line, right-click on the first note. This will 
connect to the half-tie in the previous line.

 To Insert a multiple-measure rest...
Select the n-measures object inside the Rests object group with the Insert 
function on.
Select the number of empty measures you want to insert by scrolling the 
horizontal selector bar. 
Click inside the appropriate measure. The measure must be empty of all 
other objects.
To delete a multiple-measure rest, click on it with Delete active.
To Insert or Change bar lines...

 Click on the bar line icon in the Toolbox.

Select proper bar line with Insert function active. Click anywhere in the 
MNOD window. Bar line will drop in place.



: MIDI conversion will treat all bar lines as single bar lines regardless 
of its implied interpretation.

To delete a bar line, click on any bar line in the MNOD window with Delete 
function active.
Inserting Beamed Notes
Look for the first note of a beamed group. CNTRL-click on that note. Notice 
that the cursor not only takes on the selected notes value, but also inherits 
its beam direction. 

You may also select the beam direction of any note with a value of 1/8 or 
shorter from the note object group. Click on a flagged note duration. Then 
select the right beam icon. 
When Inserted, this note will become the first of a beamed group.
Toggle the A key. Notice how the beam direction cycles between Right, 
Middle and Left orientation. Inserted notes will attach themselves to existing 
beamed groups according to the selected attribute.
Right and Left beams will begin or terminate a group.
A Middle beam will insert itself between two existing beamed notes by 
extending the beam in either direction.
Changing Beamed Directions
To change the beam direction of an existing beamed note, toggle the Z key 
to Change mode. Toggle the B key to select the appropriate beam direction 
and click on the note.
Auto-Save
The open MNOD file is automatically saved to a backup file, filename. bak, in 
the working directory.
 To change the time interval for Auto-Save, go to File>Auto Save in the Main 
Menu. Select a time interval for Auto Save. The default is ON; Save every 5 
minutes.
Save MNOD Files
When you are finished editing the MNOD file, go to File>Save. Your edited 
MNOD file will now be saved. 
Save your edited MNOD file with the default name or rename it. Click OK.
It is not necessary to save the MNOD file prior to MIDI conversion. However, 
it is recommended to ensure that your edited MNOD file is saved to disk.

Associating MNOD files with MIDISCAN



Windows allows for programs that create files with unique extensions, 
like .MND, to automatically open when the listed filename is double-clicked in
File Manager. 
To open MIDISCAN from File Manager...
In File Manager, find any filename with an extension of .MND. Click it once to 
highlight.
Go to File>Associate from the Menu. Windows asks you to select an 
application to associate with all .MND files.
Use Browse and locate C:MIDISCAN>MIDISCAN.EXE.
Press OK. From now on, whenever you are in File Manager, double-click any 
file with .MND to open MIDISCAN.

Undo
 There is no UNDO in MIDISCAN Ver. 2.0.



MIDI Conversion

The final step in MIDISCAN is to convert your MNOD file to a MIDI file. 

MIDI Setup

K Select MIDI Setup icon from the Toolbar.

In Devices, select your installed MIDI device driver. It should already be 
installed through Windows Prog-Man>Control Panel>Drivers. If you do not 
have a MIDI driver installed, refer to the documentation provided by the 
manufacturer of your sound and/or interface card.
If you are converting a piano score (2 staves per system) select a Balance 
setting to create instant MIDI stereo by pre-selecting the pan position for left 
and right hands: Hard= 100% right/left pan, Soft=75% right/left pan, 
Middle=50%.
If you want MIDISCANs internal sequencer to open following MIDI conversion,
check Open sequencer....
MIDI conversion goes through several steps before saving the MIDI file; voice 
lines are extracted from MNOD, pickup and closeout measures are 
calculated, the MIDI file is created and MNOD is reconstructed. After a few 
moments, the file selector popup appears automatically with 
File>Save[filename].MID. 
Change the name of the MIDI file, if desired. Click OK.

MIDISCANs playback sequencer will open. If your MIDI-out port is already 
occupied by an open music application, you will be told.



MIDI Sequencer

 The MIDI sequencer may be opened at any time by pushing the Sequencer 
icon in the Toolbar. MIDISCAN always loads the MIDI file associated with any 
open MNOD file. 

Push Play to begin playing back the current song.
Real-time parameter settings...
Push Instrument List to select either GM (General MIDI), MT32 or numerical
instrument preset to match your soundcard or synthesizer.
Change instrument (patch) presets for each MIDI channel.
Use the Tempo slider to adjust tempo.
Adjust individual or global Volume.
Mute a track while all others play or Solo a single track.
Use Pan to create a stereo image.
Refer to Measure and Beat readout when Rewinding (Rew) or Fast 
Forwarding (FF).
Push Open to load any standard MIDI file from disk.
Push Exit to exit the sequencer and return to the previous MNOD display.



MNOD To MIDI Considerations

The following are a few things to keep in mind prior to converting MNOD files 
to MIDI files.

Time and Key Signatures
MIDI sequencers and notation applications require that imported MIDI files 
contain a time signature. 
Check that the first measure in MNOD has the correct time signature. From 
the Main Menu, select Edit MNOD>Unify Key and Time Signatures. This 
will unify all time signatures throughout the score based on whatever time 
and key signature is found in the topmost staff line. If no time signature 
appears in the first measure, MIDISCAN will arbitrarily insert 4/4 as the 
signature.
: If a change-of-key or change-of-time signature is encountered in staff

#1 of the score, the change will become effective until another 
change is found.

To unify key or time signatures throughout the score, select Edit MNOD>Unify
Key [Time] Signatures.

Voice Lines
MIDISCAN extracts voice lines from MNOD files using certain rules. Points to 
remember with multiple voices are:
Note and rest events belonging to separate voices that occur at the same 
moment must be aligned vertically in MNOD, regardless of how they may be 
horizontally offset relative to one another in the original notation.
Often publishers will allow a partial voice line inside a multiple-voice 
measure. You may need to fill out a voice line with rests in order for 
MIDISCAN to extract the line.
Pickup and Close Out Measures
In MIDI conversion, rests are inserted at the beginning of a pickup measure. 
When its associated close out measure is encountered, rests are inserted at 
the end of the measure.
Importing MIDI files into Notation Software
MIDI does not contain any information about how a score ought to appear as 
standard notation. When a MIDI file is imported into an application that 
supports music notation, the reading program must apply internal rules to 
determine such things as stem direction, beam sequences, Tuplets and even 



where to put rests, since standard MIDI files do not contain information for 
these attributes. Some notation programs apply superior sets of rules than 
others...
As of the date of this publication, no universal file format for music notation 
has been developed. In February of 1994, several of the major music 
software companies, including Musitek, met to begin development of such a 
universal notation format. Many existing music software applications will 
begin supporting NIFF (Notation Interchange File Format) as soon as the 
format is published sometime in late 1995.



Editing Image Files

If your original sheet music is especially dirty, contains many guitar tablature
chords impinging on top of staff lines or has a lot of blobs on or near the 
staves, you may want to eliminate them first. See To eliminate unwanted objects 
in the image....
: Normally it is not necessary to edit out spurious objects. Even if such

objects were picked up during recognition, deleting them in MNOD is 
usually faster and easier.

Importing Image Files

Push the Open Image icon in the Toolbar. Select an image file, i.e:
[FANDANGO.TIF] 
To reverse the image...
If the image you open in MIDISCAN is white-on-black (instead of the normal 
black-on-white), then you should reverse the image output in your scanning 
software. MIDISCAN defaults to 0=white polarity. 

Editing Image Files 
To zoom in and out of image...
Choose View from the Menu Bar and selecting a scale. The default view is 
1/1. 1/4 view gives an excellent birds eye view. 1/2 and 1:1 are good for 
close-up work. Full Page View is intended only for display and is not 
editable. 
To eliminate unwanted objects in the image...
With your left mouse button, describe a box around the objects you wish to 
eliminate. If your score contains guitar chords (tablature), it helps to 
eliminate them first, especially if they are close to the staves.
Hit the Delete key on your keyboard or select Edit>Delete from the menu 
bar. Reset the location of the bounding box with a click of the right button if 
necessary.
Continue this practice until youre happy...but dont overdo it, MIDISCAN is 
trained to ignore most information that doesnt translate into MIDI.
To rotate image 90o...

Landscape scans may be re-oriented prior to processing.
Go to Edit Image and select Rotate Left or Rotate Right depending on 



the orientation of the original scan. 
To draw lines of variable widths...

Sometimes a score has extremely thin or weakly-printed horizontal staff 
lines. This condition may create problems for MIDISCAN in its attempt to 
localize beginning and ends of staff lines. Less often, but no less problematic,
is the score that does not group staves into systems with a vertical bar or 
bracket along the left-hand margin. In this case, MIDISCAN would have 
trouble deciding which staves belong to which systems.
With an image loaded, select the Draw Line icon from the toolbar 
(Edit_Image>Line Draw in Main Menu). 

In the Toolbar, a slider appears with two color selectors. Select the color you 
want for the line by pushing one of the color selectors, top for foreground / 
bottom for background. 

Move the slider horizontally to select the width of the line you wish to draw... 
from 1 to 10 pixels wide.
In the image area, click and hold at the start point, drag and let go at the end
point of the line. To move the line, click, hold and drag the square in the 
middle of the line. To extend the line, click, hold and drag either of the 
squares at the endpoints. When satisfied with the width, length and position 
of the line, right-click inside any of the squares.
To erase a portion of a drawn line, select the background color and draw a 
line segment over the area of the line you want to erase.
To draw freehand in image area...

You may wish to draw in certain features that may be missing, for example, 
fill in note heads that may be poorly printed.

Zoom in to 1:1 View. Push the Pixel Draw icon in the Toolbar. Use the mouse 
to drag and draw in the image area. The draw tool creates a 3 pixel x 3 pixel 
path along the area you drag the mouse.
To save an edited image file...
Go to File>Save, File>Close or to File>Save As..
Click on the original filename (grayed-out in the selector list). Click on OK. 
(File>Save_image saves automatically).



File Management

A good idea is to set your scanning software, MIDISCAN and MIDI programs 
to the same working directory so that they all look to the same directory 
when opening and saving files. 
To view the working directory of any Windows program,
In Program Manager, click once on a program icon. In the menu bar, select 
File>Properties>Working Directory. The last directory listed in the 
pathname will be the first directory the program will go to for opening and 
saving files. 
: You cannot set a working directory to one which doesnt already first 

exist. 
To create a new directory,
In Windows, go to File Manager inside the Main Program Manager group. 
Select File>Create Directory. Type the new directorys name. Notice that the 
new directory will become a subdirectory to whatever folder is highlighted. 
In DOS, use the command >mkdir after the prompt.
image Perhaps you do not want to store all your, MNOD and MIDI files in one 
directory. You may want to have a separate subdirectory for each score. 
There is no right way. Decide what works best for you then try to maintain 
consistency.
To Change the Working Directory of any Windows Program,
In Program Manager, click once on a programs icon to highlight it. Go to 
File>Properties menu item and in the Working Directory dialog box, type
the pathname to a preexisting directory, for example: C:\MIDISCAN\NEW. 
When Open, Save and Save as commands are used, the program will look 
first to the selected working directory.



MIDISCAN Reference
When MIDISCAN first opens, a grey screen appears with the Toobar in the 
upper region. 
Any of the following icons may be selected:

Open an existing MNOD file

Open an existing image file (TIFF, BMP or PCX).

Scan a new piece of music with aTWAIN-compatible scanner.

Begin recognition of a pre-scanned image.

Open the MIDI sequencer and load an existing MIDI file.



MNOD Editor

After opening an MNOD file or recognizing an image file, the MNOD Editor 
becomes active. These remaining Toolbar icons are accessable in the MNOD 
Editor: .

Close and save the existing MNOD or image file.

Open MIDI Setup window prior to MIDI conversion.

Insert Mode.

Change Mode.

Delete MNOD object from selected group.

Delete any MNOD object.

Quick-group MNOD objects. See "Quick-group Icon".

Zoom Out.

Zoom In.

Close / open the Image Window. Close / open MNOD Window

To open an .MND file, push the Open .MND icon. In the Open File dialog box, 
and click on a .MND filename. This will bring up the first page of the MNOD 
file in the MNOD window on the lower half of the screen. The corresponding 
image page appears in the image Window above the MNOD window.
Click on the vertical scroll bar to move lower along the page. Click on the 
horizontal scroll bar to move across the page. Both the MNOD-page and the 
image-page will move concurrently. 



Click the down arrow in the lower right-hand corner of the window to bring up
the next page. Clicking on the up arrow in the vertical scroll bar opens the 
previous page.
: Although image-pages and MNOD-pages scroll together, the MNOD 

file is seamless while each image-page is an individual file.



Menu Pulldown Selections

File 
View Image
Selected image files will quickly load and display on the screen. No editing of
the image file will be possible in View Image.

Open
Opens File Selection dialog box and lists saved files. A selected file will be 
loaded into memory and will display on the screen. Select file type. Available 
file types are:
TIFF (compressed and uncompressed) 
BMP and PCX
 MNOD Will load the entire scores MNOD file into memory and associated 
pages. Clicking on the down arrow in the lower right-hand corner scrolls to 
the next TIFF and MNOD pages.
Select disk drive, working directory folder and scroll to the desired filename. 
Click on OK to select. Click on Cancel to exit Open.
Scan Music
Selects scanner TWAIN driver and initiates scanner to aquire image.
Recognition
Initiates Recogntion to begin processing saved image files.

Save
Writes currently displayed file to the hard disk. If MNOD and image are 
displayed, the MNOD file is saved.

Save As..
Opens Windows File Selection dialog box.

Save processed or modified .MND files or .TIF files to hard disk following 
Recognition and MNOD Editing procedures. 
Use to save selected files to directory other than the working directory.
Auto-Save
Opens Auto-Save preferences window. Select changes to default.

Print



Initiates Windows Print Monitor. Current MNOD file is output to default printer
from selected printer port.

Close
Closes the currently displayed file. If any changes were made to the open 
file, Save dialog box opens.

Exit
Exit MIDISCAN. Save current file. Go to the Windows main desktop.

View
Full Page View
Allows for previewing the entire active image page. However, the displayed    
image is not editable in the full-page mode.

Image Info
Provides information on the structure and type of the currently displayed 
image file.

Show Cursor
When activated, the mouse cursor is visible.

Show MNOD Object
Displays the active MNOD object next to the cursor. For example, left-click on
the first note of a beamed sequence. With MNOD object active, the note with 
the open right beam will appear.

Show Toolbar
Opens and closes Toolbar.

ImageWindow
Displays current image window in full-screen mode. The associated MNOD 
window is removed from the screen.

MNOD Window
Displays the current MNOD page in full-screen mode. The associated image-
page is removed from the screen.

Inverse Image
Reverses the polarity of the displayed    image.

Zoom



Lists available view scales. Changing views will affect both the current image
and MNOD files simultaneously. Available views, from smallest to largest 
scale include, 1:4, 1:2, 1:1, 2:1 and 4:1. Full-page view deactivates the 
current MNOD file.

Background Color
You may change the color of the Image and MNOD window backgrounds by 
selecting a color from the color chooser. 

Recognition
 Initiates the recognition sequence and opens the recognition setup dialog 
box. See "Music Recognition". 

Edit MNOD



MNOD Toolbox
 Opens and closes the MNOD Toolbox on the left-hand side of the screen.

Unify Key and Time Signatures
Automatically checks key signatures for consistency. Unifies key signatures 
based on the key signature found in the first stave. See "Time and Key 
Signatures".

MIDI
Setup
When opened, MIDI Setup allows for assigning of MIDI device driver, balance 
and initiates MNOD to MIDI conversion.

Begin MIDI Conversion
Converts current MNOD file into a Standard MIDI file. Opens Save As.. 
Defaults to open filename with a .MID extension.

Open Sequencer
Opens MIDI sequencer. MIDI file associated with any open MNOD file is 
automatically loaded.

Help
Contents

Opens the Help File. Defaults to the Contents selection section of the Help 
File.
About

About MIDISCAN, Musitek and program copyright.



Image Editor

Editing the image file prior to recognition sometimes improves recognition 
accuracy and speed. Scanned image files stored to disk are opened by 
pushing the Open Image icon in the Toolbox searching the image extension 
group pulldown menu. Extension groups includes TIFF (compressed and 
uncompressed), BMP and PCX files. Choose the desired drive, directory, 
subdirectory and filename in the dialog box. The following are menu items 
designed to edit the bitmapped image:
Cut

Removes image within a bounding box drawn with the mouse. Removed 
image is stored in memory for pasting into another part of the image. 
Drag the mouse from corner to corner of area while holding down the left 
button.
Use to place one part of the score into another area.
Copy

Stores to memory the image within a bounding box drawn with the mouse. 
Use to clone one part of the score to another that may be missing or 
damaged.
Paste

Pastes the image area stored in memory (cut writes to the clipboard) and 
inserts it into the open bitmapped image.
Delete

Deletes an area of the image defined by a box. Used to clean up particularly 
dirty parts of the image including guitar chords that impinge into the 
Recognition region
Draw a box around the image area to be eliminated by dragging the mouse 
with the left mouse button held down.
Click Edit_Image>Delete.
: Pressing Delete button also accomplishes this.
Select All

Makes the entire image of the image-page active. Required before inverting 
polarity of image or before resetting it to normal polarity.
Normal / Invert



Reverses the polarity of the active    image.
Opaque / Transparent

When active, only the ink or black pixels in the foreground will be cut and 
pasted. Background is ignored.



Main Menu Items

The following table lists MIDISCANs main menu items:
MIDISC

        File View Recog-
nition

EditMNO
D

MIDI Help

View
Image

Full Page Begin
Recog.

MNOD
Toolbox

Setup Contents

Open.. Image
Info

Unify Key
& Time

Sig.

MIDIConv
rt.

About

Scan
Music

Show
Cursor

Open
Sequence

r

Recog-
nition

Show
MNOD

Save Image
Window

Save As.. MNOD
Window

Auto-
Save

Inverse
Image

Zoom

Back-
ground
Color

MIDI Implementation

MIDI Implementation Chart
Controller / Data Value

Parts Per Quarter note (Resolution) 240



Default Note Velocity 85
Default Channel Volume (Controller #7) 100

Default Expression Setting 127
Pan Pot              Track 1            Track 2

            All Tracks
0127
64

Default Output Port 1
Track #2 (First Data Track) Channel Assignment 1

Default Instrument List GM



Problem Solving



Troubleshooting Chart

The following chart is intended as a guide in solving the most commonly 
encountered problems in MIDISCAN. Please refer to the chart for your 
particular problem prior to calling Tech Support.
Troubleshooti

      Problem Probable Cause Solution
Scanner will not

respond after Scan
icon is pushed.

Scanner TWAIN driver
not installed into

Windows.

Refer to scanner
manual. Install TWAIN

software driver. 
Image from hand
scanner does not

capture entire
page of original

music.

Hand scanners are
usually about 4 wide.

Save each horizontal
pass of hand scanner
as a separate image

file. Batch-process each
image-page.

Original score is
longer than it is

high.

Score is printed in
landscape format.

Scan score sideways. In
Edit Image, select
Rotate image 90o

(left or right).
Original score

extends beyond
edges of the

scanner.

Music is printed on a
variety of formats;

some larger than A4
and B4 folio sizes.

Reduce image size of
original on copy

machine.

Scanned image
appears distorted
when displayed in

MIDISCAN.

Image was scanned in
as a Grey-scale

image.

Rescan and save image
as Black-and-White,
Line Art, Drawing or

Binary. 
Unable to get

passed
Recognition

Setup dialog box.

Conflict with naming
convention used in
third-party Windows

utilities.

If running Symantecs
Norton Desktop,

globally disable File
Assistant. Restart.

Unable to get
passed File

Selection dialog
box prior to
Ensemble

Recognition.

Conflict with video
accelerator card

and/or older video
driver.

Conflict with existing
TSR.

Ensure latest version of
driver software is
installed. Reset

Windows display to
VGA. Recognize as Part
Score (up to 2 staves).

MIDISCAN runs out
of memory during

recognition.

Music scanned in at
too high a resolution.

Rescan music at 300 to
400 dpi.

Very few notes
appear when

MNOD file opens.

Notation printed in
small font styles or is
of non-standard size.

Enlarge original on
copy machine. Rescan.

Rescan music with



increase scaling or
rescan music at 350 to

400 dpi.
Notes and symbols
missing from the

beginning of
MNOD staff lines.

Full region of the
notation field not

captured in the TIFF
image.

Rescan page ensuring
field boundary fully

encompasses all music
on the page.

Whole notes
appear in clusters
above the top staff

line.

MIDISCAN tried to
turn guitar chord

symbols or dynamic
markings into notes.

Delete spurious objects
in MNOD editor or open

and edit image file.
Resave and reprocess

image file.
Notes or beams

missing from notes
that extend above

or below a staff
line.

Recognition Region
too narrow. Note
features cut off.

Select Wide Recognition
Region. Restart

recognition sequence.

MNOD to MIDI
conversion hangs.

Unexpected events
occurring at end of a
particular staff line.

Barlines missing from
end of staff.

Check right-hand
margin of display. Insert
missing bar lines at end

of staves.

MIDI Sequencer
doesnt open after
converting MNOD

file to MIDI file.

MIDI-Out port
occupied by another
sequencer / notation

program.

Close any open
sequencer / notation

programs. Push
Sequencer icon in
MIDISCAN to open.

No MIDI driver
installed.

Install sound card or
MIDI interface device

driver in Windows
Setup>Drivers.

Sequencer plays
but no sound is

heard.

Windows MIDI mapper
not edited; Incorrect
MIDI-out port device

selected. 

Edit Windows
Setup>MIDI Mapper.
Match MIDI-out device
with installed drivers. 

IRQ conflict. Check IRQ settings.
Refer to soundcard or

MIDI interface card
documentation for
correct settings.

MIDI file garbled
when played back. 

MNOD file not edited
following recognition.

Return to MNOD
display. Edit

misrecognized objects.
Reconvert to MIDI.

MIDI playback
sounds jerky;

timing off. 

Incorrect time
signature in MNOD file
following recognition.

Check key and time
signatures. Select Edit
Image > Unify Key

and Time. Reconvert
to MIDI.



Note pitches of
one MIDI track out

of tune when
played back. 

Clef sign at beginning
of staff line incorrect.

Open and edit MNOD
file. Reconvert to MIDI.

Locator tabs
improperly positioned.

Reprocess recognition
in User Confirm mode
and manually check

locator tabs.
Music doesnt look

the same when
imported into

notation software.

MIDI does not contain
notation information.

Notation software
needs to interpret

MIDI file for
attributes.

Wait until NIFF
(Notation Interchange

File Format) is
universally supported

(late 1995).

System
A grouping of multiple staff lines linked together by a solid line or bracket 
along the left margin is called a system. All staves belonging to a system are 
played simultaneously. In ensemble scores, each system appends to the one 
before it. A single page of a symphony conductor's score, containing 10 or 20
staff lines per system, may represent only a few seconds of music!



Staff Line (Stave)
The field on which notes are represented is called a staff or stave. At the core
of every stave are five horizontal staff lines. Each successive line and space 
are equivalent to a full step in note pitch. The higher the note appears on the
stave, the higher its pitch. Every stave is associated with a particular clef 
sign which determines its relative position within the full pitch spectrum.



Clef Sign
The clef sign at the beginning of each stave identifies which pitch class that 
stave belongs to. The lowest instruments are written in the bass clef, 
intermediate instruments and voices often use one of three C clef classes 
while higher-pitched instruments, in addition to the right-hand part of a piano
score, are scored in the treble clef. The clef sign always appears at the 
beginning of every staff line and in the first measure where a change of clef 
sign occurs.



Key Signature
The key signature, along with the clef sign, appears at the beginning of every
line; it is also found in the measure where a change of key occurs. The key 
signature defines the tonal center of the piece. By counting the number of 
sharps or flats in the key signature, the key signature can be determined. 



Time Signature
Time signatures usually appear only once: at the beginning of the stave in 
the first measure of the piece. They will also appear when a change of time 
signature occurs. Time signatures indicate both the number of beats per 
measure (numerator) as well as which note value is given the fundamental 
beat (denominator). The sum of note duration values in a given measure 
must equal the value of the current time signature.



Measure
Staff lines are segmented into equal time divisions called measures. 
Measures are the building blocks that provide structure for music. The sum of
note and rest durations within each measure must equal the value of the 
current time signature. 



Bar Line
Bar lines are the vertical lines which define the beginning and ending of 
measures.



Note/Rest
A note is the fundamental unit of tone. The duration of a note is determined 
by a) its note value and b) the tempo at the moment it is sounded. The notes
vertical position on a particular staff line determines its pitch. 
Rests are equivalent to note durations but instead, they represent silence. 
They are like place-holders used to keep the rhythmic structure of the 
measure intact. 



Accidental
Note pitches often range outside of the tonal center defined by the key 
signature. An accidental shifts its associated note up (sharp) or down (flat) 
by 1/2 step. Accidentals may also be doubled. An accidental remains 
effective only for the remainder of the measure in which it appears. A natural
cancels a notes current accidental.



Dot of Prolongation
Notes and rests that are dotted have the value of their duration lengthened 
by 1/2. For example, a dotted quarter note is equal in duration to three 
eighth notes. Double-dotted notes increase the notes duration by 3/4 of the 
original.



Tuplet
Some notes belong to a special rhytmic class called tuplets. These include 
triplets, quintuplets and sextuplets. A tuplet is a group of notes, usually 
marked with a bracket, that are subdivided within a single beat, equal in 
duration to the notes next higher value. For example, a triplet of three eighth
notes is equal in total duration to one quarter note.



Tie
A tie links two pairs of notes of the same pitch whose durations are 
combined so that both notes are played as if one note. Ties are often used to
sustain the sound of a note across more than one measure.




